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About This Manual

This manual contains basic information to get you started developing
programs with ComponentWorks ActiveX controls so that you can acquire,
analyze, and present data within any ActiveX control container, including
Visual Basic.

Using ComponentWorks Documentation to Get Started

This manual is designed to teach you the fundamentals of developing
Visual Basic programs with ComponentWorks ActiveX controls through
interactive discussions and examples. If you are new to Visual Basic or
ComponentWorks ActiveX controls, read this manual at your computer so
you can test the discussion and concepts.

If you are working in an ActiveX control container other than Visual Basic,
spend some time programming in your development environment. Check
the documentation that accompanies your programming environment for
getting started information or tutorials, especially tutorials that describe
using ActiveX controls in the environment. If you have specific questions,
search the online documentation of your development environment.

Before you begin, refer to Chapter 1, Introduction to Measurement Studio
and ComponentWorks, for installation information and a ComponentWorks
overview, and then use the following questions and answers to assess what
you should do next.

Are you new to using ActiveX controls?

Read Chapter 2, Getting Started with ActiveX Controls, for introductory
information about ActiveX controls and why they are so useful. Then move
on to Chapter 3, Getting Started with ComponentWorks in Visual Basic,
to complete a ComponentWorks tutorial in Visual Basic.

Are you familiar with ActiveX controls but need to learn
ComponentWorks controls and features?

If you are already familiar with using ActiveX controls, including
collection objects and the Item method, refer to the ComponentWorks
online reference (Start»Programs»National Instruments»
Measurement Studio»Online Help»ComponentWorks Reference
for Visual Basic).

© National Instruments Corporation vii Getting Started with ComponentWorks
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Do you want to develop applications quickly or modify existing
examples?

If you are familiar with using ActiveX controls, including collections and
the Ttem method, and have some experience using ComponentWorks or
other National Instruments products, you can get started more quickly by
looking at the examples installed in MeasurementStudio\Vb\Samples.

Most examples demonstrate how to perform operations with a particular
control or group of controls. To become familiar with an individual group
of controls, look at the example for that particular group. Then, you can
combine different programming concepts from the different groups in your
application.

The examples include comments to provide more information about the
steps performed in the example. The examples avoid performing complex
programming tasks specific to one programming environment; instead,
they focus on showing you how to perform operations using the
ComponentWorks controls. When developing applications with ActiveX
controls, you do a considerable amount of programming by setting
properties in the property pages. Check the value of the control properties
in the examples because the values greatly affect the operation of the
example program. In some cases, the actual source code used by an
example might not greatly differ from other examples; however, the values
of the properties change the example significantly.

@ Tip ComponentWorks installs only Visual Basic examples. Visit the ComponentWorks
Web site at www.ni.com/cworks for Visual C++ and Borland Delphi examples.

Do you want more information about solving industry-specific
problems?

Refer to National Instruments online at www. ni . com for information about
building measurement and automation programs with any National
Instruments product. The ComponentWorks online reference includes
several ComponentWorks application notes to help you solve industry
problems. Check the Application Note library for more technical notes and
tutorials written to help you solve specific measurement and automation
problems with National Instruments products.
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As you work with ComponentWorks, you might need to consult other
resources if you have questions. The following sources can provide you
with additional information about ComponentWorks:

@ Tip Refer to the documentation that you received with your development environment for
information about working in the environment, learning the tools, and writing code.

© MNational Instruments Corporation

ComponentWorks Reference—Complete reference information for all
ComponentWorks controls. You can access this help from the
Windows Start menu (Programs»National Instruments»
Measurement Studio»Online Help» ComponentWorks Reference
for Visual Basic).

ComponentWorks Examples—The ComponentWorks installer copies
Visual Basic examples to Measurement Studio\Vb\Samples. Use
these examples to get started developing your own programs. Visit the
ComponentWorks Web site to download examples for Visual C++ and
Borland Delphi.

ComponentWorks Web Support at www.ni.com/cworks—
ComponentWorks news and evaluation software, examples, technical
product tutorials, customer solutions, and Internet-based virtual
instruments.

National Instruments Web Support at www.ni.com—Examples,
FAQs, a searchable KnowledgeBase, and the Application Notes
library.
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Conventions

»

bold

italic

monospace

monospace bold

The following conventions appear in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence Tools»Options»Environment directs you
to pull down the Visual Basic Tools menu, select the Options item, and
change environment properties on the Environment dialog box.

This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options.

Ttalic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of paths, directories, programs,
procedures, functions, operations, variables, filenames and extensions, and
code excerpts.

Bold text in this font emphasizes lines of code that are different from the
other examples or indicates that you must add code to the example.
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Introduction to
Measurement Studio and
ComponentWorks

This chapter introduces Measurement Studio and ComponentWorks and
lists system requirements and installation instructions.

Measurement Studio Overview

Measurement Studio bundles LabWindows/CVI for ANSI C programmers,
ComponentWorks for Microsoft Visual Basic programmers, and
ComponentWorks++ for Microsoft Visual C++ programmers to deliver
measurement and automation components in the programming
environment of your choice.

The Measurement Studio Base package includes the instrument control,
user interface, base analysis, and Internet tools you need for building
common measurement and automation programs. The Measurement
Studio Full Development System adds to the Base package digital signal
processing (DSP) and advanced analysis components. ComponentWorks
includes IVI controls in the Full Development System.

ComponentWorks Overview

ComponentWorks is a collection of ActiveX controls for acquiring,
analyzing, manipulating, and presenting data within any ActiveX control
container. The ComponentWorks ActiveX controls are designed for use in
Visual Basic, and some ComponentWorks features and utilities have been
incorporated with the Visual Basic user in mind. However, you can use
ActiveX controls in any application that supports them, including
Microsoft Internet Explorer, Microsoft Visual C++, and Borland Delphi.
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You can use either of the Measurement Studio packages to easily develop
complex custom user interfaces to display your data; acquire data with your
National Instruments Data Acquisition (DAQ) boards; control serial, GPIB,
and VXTI instruments and controllers; analyze the data you acquired from a
device; or share live data between different applications over the Internet.

ComponentWorks offers smaller, more focused ComponentWorks
packages as well. The ComponentWorks Starter Kit includes the essential
user interface and instrument tools you need to build a measurement
application in any ActiveX control container. If you are developing
machine vision or imaging applications, building automation interfaces, or
controlling processes with PID algorithms, ComponentWorks offers the
ComponentWorks IMAQ Vision, Automation Symbols, and Autotuning
PID packages.

The following list describes the functionality that ComponentWorks
ActiveX controls can add to your custom programs:

e User Interface Controls (Starter Kit, Measurement Studio Base and
Full)—Present your data in a technical format. These controls include
a graph/strip chart, slides, thermometers, tanks, knobs, gauges, meters,
LEDs, and switches.

e Three-Dimensional Graph Control (Measurement Studio Base and
Full)—Visualize three-dimensional data on a user interface.

¢ DAQ Controls (Starter Kit, Measurement Studio Base and
Full)—Perform analog /O, digital I/O, and counter/timer I/O
operations using National Instruments DAQ products.

¢  GPIB, Serial, and VISA Controls (Starter Kit, Measurement Studio
Base and Full)—Control and retrieve data from instruments or devices
connected to a serial, GPIB, or VXI port in your computer. You must
connect GPIB instruments with a National Instruments GPIB interface
card.

e DataSocket Control and Tools (Measurement Studio Base and
Full)—Share live data between applications or HTTP, FTP, OPC,
and file servers.

¢ IVIControls (Measurement Studio Full)—Control scopes and DMMs.
With IVI, you can develop hardware-independent test systems,
isolating your test programs from changes in the instrument hardware.

*  Analysis Library Controls (Starter Kit, Measurement Studio Base and
Full)—Functions for statistics, advanced signal processing,
windowing, filters, curve fitting, vector and matrix algebra routines,
probability, and array manipulations. Refer to the ComponentWorks
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online reference to find out which analysis functions are available in
your ComponentWorks package.

IMAQ Vision Controls (ComponentWorks IMAQ Vision)—Acquire
images from National Instruments image acquisition (IMAQ) boards,
display them in your program, perform interactive viewer operations,
and analyze your images to extract information with the
ComponentWorks IMAQ Vision package.

Industrial Automation Controls (ComponentWorks Automation
Symbols)—Build advanced custom user interfaces for your industrial
process monitor or control programs. The ComponentWorks
Automation Symbols package includes controls for pipes, motors,
pumps, valves, and vessels.

PID Control (ComponentWorks Autotuning PID)—Control programs
based on proportional-integral-derivative (PID) controllers. For
example, you might use the ComponentWorks Autotuning PID
package to control processes such as heating and cooling systems,
fluid level monitoring, flow control, and pressure control.

System Requirements

To use the ComponentWorks ActiveX controls, your computer must have
the following:

© National Instruments Corporation

Microsoft Windows 2000/NT/9x operating system (Windows NT users
need NT 4.0 to use the DAQ controls)

ActiveX control container such as Microsoft Visual Basic
(32-bit version)

Appropriate hardware and driver software if you are going to use a
ComponentWorks I/O control, including DAQ, Serial, GPIB, VISA,
IVI, or IMAQ

33 MHz 80486 or higher microprocessor (66 MHz 80486 or higher
microprocessor recommended)

VGA resolution (or higher) video adapter
Minimum of 16 MB of memory

Minimum of 85 MB of free hard disk space for the Measurement
Studio Full Development System

Microsoft-compatible mouse
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Installation Instructions

You can install ComponentWorks from the Measurement Studio CD. The
setup program installs different components depending on the package you
purchased.

@ Note If you have an earlier version of ComponentWorks installed on your computer,
uninstall that version before installing ComponentWorks 3.0 or later. To uninstall
ComponentWorks, select Start»Settings»Control Panel»Add/Remove Programs.
Select National Instruments ComponentWorks from the list of programs and press the
Add/Remove button.

1. Install driver software and hardware if you need to acquire data or
control instruments in your program. Driver software performs the
low-level calls to your hardware. You must install and configure the
corresponding driver software and hardware before you can use any of
the ComponentWorks hardware I/O controls, including the DAQ,
GPIB, Serial, VISA, IVI, and IMAQ controls.

@ Tip Some ComponentWorks controls require features provided only in the newest
versions of the driver. You can download the most current driver from the National
Instruments Web site at www.ni .com.

2. Install your hardware device. Refer to your hardware installation guide
for installation information.

3. Configure your device with National Instruments Measurement &
Automation Explorer. After configuring your hardware, Measurement
& Automation Explorer contains information about the hardware that
you might need to use ComponentWorks I/O controls. For example,
use the device number from Measurement & Automation Explorer to
specify a device with a ComponentWorks I/O control.

4. Insert the ComponentWorks CD in the CD drive of your computer.
From the CD startup screen, click Install ComponentWorks. If the
CD startup screen does not appear, use Windows Explorer to run the
SETUP . EXE program from your CD.

5. Follow the instructions on the screen.
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The ComponentWorks setup program installs the following groups of files
on your computer when you install the ComponentWorks Starter Kit,
Measurement Studio Base package, or Measurement Studio Full
Development System:

e  ActiveX controls (. ocx), help files (. hlp, . cnt), and associated files:
\Windows\System

*  Example ComponentWorks programs for Visual Basic:
\MeasurementStudio\Vb\Samples\

*  Application notes and this manual in PDF format, which you can view
with Adobe Acrobat Reader 3.0 or later:

\MeasurementStudio\Vb\Documentation

e Miscellaneous files:

MeasurementStudio\Vb\
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Getting Started with
ActiveX Controls

This chapter contains introductory information about ActiveX controls.

What Is an ActiveX Control?

ActiveX controls are reusable software components that you use within any
ActiveX control container to maximize software reuse, increase
productivity, and improve quality in your programs.

An ActiveX control encapsulates, or contains, three different
parts—properties, methods, and events—that you will modify, call, and
define to take advantage of the control’s functionality in your program:

*  Properties define attributes of a control, such as the way a control looks
on the form or the initial state of the control when you run the program.
Refer to the What Are Properties and How Do I Get and Set Them?
section later in this chapter for information about using properties.

*  Methods are functions that perform a specific action on or with an
object. Refer to the What Are Methods and How Do I Call Them?
section later in this chapter for information about calling methods.

*  Events are notifications generated by an ActiveX control in response
to some particular occurrence in the program, such as a mouse click on
a user interface control or a completed acquisition. Refer to the What
Are Events and How Do I Define Them? section later in this chapter
for information about defining event procedures.

An ActiveX control is a group of components or software objects, where
each object encapsulates and exposes one specific functionality and all of
the objects work together to provide the entire functionality of the control.
The main object of an ActiveX control contains some properties that store
property values and some properties that access other objects in the control.
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Getting Started with ActiveX Controls

Figure 2-1 shows two Knob controls that might appear on a user interface.
Each pointer, label, and value pair you see on the knob is an object. The
ticks also are an object. Notice how each object contributes to the
functionality of the entire knob. Pointers define the current value or values
of each knob. Ticks help you determine the position of the pointers. Labels
and value pairs describe the pointer positions by number or name.

Captions

Knob A Knob B

4 [ Medium

Labels —» 3

Value Pairs

Low High

Ticks Pointers

Figure 2-1. Each Object Contributes to the Functionality of the Entire Control

By manipulating individual objects on the control, you can create two very
different configurations. In Figure 2-1, Knob A uses a standard numerical
scale from 0 to 10, while Knob B uses three value pairs instead, where Low
equals 0, Medium equals 5, and High equals 10. Knob A has two pointers,
yet Knob B has a single pointer. Notice the subtle differences in appearance
as well. Knob A has ticks, while Knob B does not. Knob A uses
three-dimensional pointers, and Knob B uses a thin pointer.

To manipulate an individual object, you must access it through the control
hierarchy. Figure 2-2 demonstrates the link between software objects in the
CWKnob control. The main object of the CWKnob control contains
properties to store the value of the property, such as Caption, and other
properties to access other objects in the control. For example, the Axis
property accesses the CWAXis object, and the Pointers property accesses
the CWPointers collection object.
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CWKnob Object
Contains the Axis, Pointers,
and Caption properties

/ N\

Axis Property Caption Property Pointers Property

Contains a Caption value
such as Knob A

CWAXxis Object CWPointers Collection
Contains the Ticks, Labels, Collection of CWPointer objects
and ValuePairs properties accessed through ltem method
Ticks Property Labels Property ValuePairs Property CWPointer Object
CWTicks Object CWLabels Object CWValuePairs Collection

Collection of CWValuePair objects
accessed through ltem method

CWValuePair Object

Figure 2-2. Software Objects Access Other Objects through Properties and Methods

A collection is a special software object that manages a set of the same
objects. For example, you might need two pointers on a knob or more than
one axis on a graph. You might want to assign different styles to each
object, including different styles on a pointer or different minimums and
maximums, ticks, and labels on an axis. You can access an individual
object, such as a CWPointer object or a CWAXis object, from the collection
with the Item method.

@ Tip To learn more about the objects in the CWKnob control or the objects in any other
ComponentWorks control, refer to the ComponentWorks online reference.
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What Are Properties and How Do | Get and Set Them?

A property is an attribute of a control. Properties for a control define how
the control looks or behaves on the form or front panel of your user
interface. For example, you can customize a button to resemble several
different Boolean interfaces, such as a pushbutton, switch, or LED.
Properties also can describe the current state of the control. For example,
you can set the value of that Boolean button to on or off. You can set
properties as you design your program through property pages, or you can
get or set properties programmatically if you want to evaluate or change a
property at runtime.

You’ll need to set two types of properties: control properties and
environment properties.

Control Properties

Control properties relate directly to the functionality of the control and you
set them programmatically or with the custom property pages, if the
developers of the control created them. All ComponentWorks controls
have custom property pages.

Use the property pages to set the property values for each ActiveX control
while you are creating your program. The property values you select during
design dictate the state of the control when you first run your program.
However, if you need to change the property values during program
execution, you can manipulate the properties programmatically.

Environment Properties

Environment properties describe how an ActiveX control should interact
with the environment and the rest of the user interface that you are
developing. The development environment provides default properties
for the name of the control (so that you can access the control
programmatically), position in the user interface (so that you can precisely
place the controls programmatically or interactively, rather than dragging
and dropping), and tab stops (so that users can tab through the interface).
You can modify these and more environment properties in the
environment’s default property pages.
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Configuring Controls in Property Pages

You can set control properties in the custom property pages after you place
the control on a form. To access the control property pages, right click on
the control and select Properties. Although the layout and functionality of
custom property pages varies among controls, you’ll usually see a page or
tabbed dialog box with a variety of properties that you can set for that
particular control. The ComponentWorks User Interface custom property
pages include a preview window so that when you modify a property, you
can see how it affects the look of your control. Figure 2-3 shows the
ComponentWorks custom property pages and preview window for the
CWKnob control. Click OK when you want to apply the new properties
and close the property pages.

Property Pages | ]
Walue Pairs I Images I Advanced I About
Style | MHumeric I Fointer I Ticks I Format
Bottarn beter
Shle
’7 & Numeric " \alue pairs only El

0k, I Cancel Appli | Help |

Figure 2-3. Set Control Properties in the ComponentWorks Property Pages
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You can modify environment properties after you place the control on a

form. Although the location and layout of default property sheets varies

among environments, you can usually access them from the View menu.
In Visual Basic, select View»Properties Window. Figure 2-4 shows the
Visual Basic environment properties for the CWKnob control.

i Properties - CwKnob1 =1 E3
|cwknob1 Cwiknob =l
Alphabetic Categorizedl

[ &Hs00000052:
knob A
(CaptionColor . BHE00000058:
Causestalidation  True

Draglcon (Mone)

DragMode 0 - vbManual

Enabled True

Fonk M5 Sans Serif

ForeCalor ] aHg000000F2:

Height 2055 =l
{(Name)
Returns the name used in code to identify an
object,

Figure 2-4. Set Environment Properties in the Visual Basic Property Window

Changing Properties Programmatically

Property pages provide a quick and easy way to set properties, but
remember that you use property pages during design to set initial control
properties, and you cannot access the property pages during program
execution. If you need to change properties during program execution to
respond to user or program events, modify parameters programmatically.
For example, you might want to change the state of an LED indicator
during program execution from false to true depending on the state of an
assembly line. When the assembly line is moving, the state of the LED is
true, and when the assembly line stops, the LED changes to false. When the
line starts again, the LED reverts to true.
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Each control you create in your program has a name that you use to
reference the control in your program. The environment assigns a default
name, and you can change the name in the environment’s default property
sheets. To access a property programmatically, use the name of the control
and the property in dot notation, as in the following syntax:

control.property = value

For example, to change the value property of the LED to false, use the
following line of code:

CWButtonl.Value = False

In the this example, CWButtonl is the default name of the LED control,
and Value is the property that specifies the current value of the control.

L)

Tip The ComponentWorks Button (CWButton) supports many different display styles,
including slide switches, toggle switches, push buttons, command buttons, custom bitmap
buttons, and LEDs. To learn more about CWButton and controlling it programmatically,
refer to the ComponentWorks online reference.

In Visual Basic most controls have a default property such as value. You
can access the default property of a control by using its control name
(without the property name attached), as in the following example:

CWKnobl = 5.0

is programmatically equivalent to

CWKnobl.Value = 5.0

Some controls consist of several objects, and one object can access another
object through a property with the following syntax:

control.object.property

For example, you can access the CWAXis object from the CWKnob object
with the Axis property. To get the minimum value of the axis, use the
following syntax:

minimum = CWKnobl.Axis.Minimum

In this example, the minimum value of the axis on the knob is read and
stored in a variable named minimum. CWKnob1 is the default name of the
control, Axis is the property that accesses the CWAXis object, and
Minimum is the name of the property on the CWAXis object.
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You can display the minimum value of the axis in a Visual Basic text box
named Text1 on the user interface with the following syntax:

Textl.Text = CWKnobl.Axis.Minimum

Or you can print the minimum value of the axis:

Print CWKnobl.Axis.Minimum

What Are Methods and How Do | Call Them?

Calling Methods

A method is a defined function within the control that you use to perform
an action, like starting or stopping an acquisition or plotting data on a
graph. You call methods as you would any function in your programming
environment.

The following syntax shows you how to call a simple method that does not
require parameters:

control.method

If the method accepts parameters, use the following syntax, listing as many
parameters as needed:

control.method parameterl, parameter2

If the method returns a value and you want to save the result, enclose the
parameters in parentheses, as in the following syntax:

result = control.method(parameterl, parameter2)

For example, the ComponentWorks Analog Input (CWAI) control returns a
value after completing the AcquireData method, which synchronously
runs an acquisition. The returned value indicates if the operation completed
successfully or if a warning or error occurred. In the following example, the
value returned from the AcquireData method is assigned to a variable
(1Err):

lErr = CWAIl.AcquireData(ScaledData, BinaryCodes, 1)

You’ll see two different types of parameters: required and optional. The
method needs required parameters to perform its primary action. The
method can use optional parameters to take more precise actions or take
advantage of additional features of the method.
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@ Tip If you are unsure whether a parameter is optional, refer to the Visual Basic Object
= Browser or code completion. Visual Basic encloses optional parameters in square brackets.

Although you must include required parameters when you call the method,
you do not have to specify any optional parameters. For example, the
PlotY method for the ComponentWorks Graph (CWGraph) has a required
parameter—the array of data that you want to plot on the graph. The
following line of code plots the array ScaledData:

CWGraphl.PlotY ScaledData

The P1lotY method also has optional parameters. For example, you can
pass a second parameter to represent the initial value for the x-axis, a third
parameter for an incremental change on the x-axis corresponding to each
data point, and a fourth parameter that determines whether a column of data
or a row of data is plotted:

CWGraphl.PlotY ScaledData, 10.0, 0.1, True

Working with Collections

Collections are special objects that manage a set of like objects. For
example, a CWPointers collection object manages a varying number of
CWPointer objects.

Managing Collections

You can add or remove individual objects from a collection with the
following syntax:

'Add a new pointer to the Knob.
CWKnobl.Pointers.Add

'Remove the second pointer on the Knob.
CWKnobl.Pointers.Remove 2

'Remove all pointers on the Knob.
CWKnobl.Pointers.RemoveAll

@ Note A collection of objects is an array of objects, where the first object is at index 1.

Accessing Objects with the Item Method

Each collection object contains an Item method that you can use to access
any particular object stored in the collection. The It em method accepts one
parameter—Item—that specifies the object you want to access through the
index or name of the object in the collection.
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For example, use the following syntax to set the value of the second pointer
on a knob to 5:

CWKnobl.Pointers.Item(2) .Value = 5.0

The term CWKnob1l.Pointers.Item(2) refers to the second CWPointer
object in the CWPointers collection of the CWKnob object. In this
example, the ITtem parameter is an integer representing the one-based index
of the object in the collection. If you assign names to the objects in a
collection, you can pass the ITtem method a string containing the name of
the object you want to access. In the following example, the CWPointer
object named TemperaturePointer is being set to 25:

CWKnobl.Pointers.Item("TemperaturePointer") = 25.0

The Item method is the most commonly used method on a collection and
is referred to as the default method. Many programming environments,
including Visual Basic, do not require you to explicitly include the default
method in the syntax. Visual Basic will accept either of the following
forms:

'Ttem method specified.
collection.Item(Index) .property

or

'Item method implied as default method.
collection (Index) .property

Therefore,

'Set the second pointer to 5.
CWKnobl.Pointers.Item(2) .Value = 5.0

is programmatically equivalent to

'Set the second pointer to 5.
CWKnobl.Pointers (2) .Value = 5.0

What Are Events and How Do | Define Them?

An event is a notification generated by an ActiveX control in response

to some particular occurrence in the program, perhaps a mouse click on

a user interface button, a change in the value of a knob, or a completed
acquisition. Events exist so you can define the tasks your program should
perform when that event occurs. You define those tasks in an event
procedure. Every time that event occurs, your event procedure is called to
process the event.
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In event-driven programming, the program continuously runs and waits for
events to occur rather than continuously polling to determine if something
has changed, as in a loop-driven program. When an event occurs, the
program responds to it by executing the appropriate event procedure and
waiting for the next event to occur. Loop-driven programs execute code
sequentially from top to bottom and then loop back to the top to start
executing the same code over and over. Loop-driven programs often take
more processor time and respond slower to more frequent events.
Event-driven programming saves processor time, requires less code, and
enables you to add new controls with new functionality without rewriting
any loop-driven code.

To develop an event procedure for an ActiveX control in Visual Basic,
double click on the control to open the code editor, which automatically
generates a default event procedure for the control. The event procedure
skeleton includes the control name, the default event, and any parameters
that are passed to the event procedure. The following code is an example of
the event procedure generated when the value of the knob is changed by the
user or by some other part of the program:

Private Sub CWKnobl_PointerValueChanged (ByVal_
Pointer As Long, Value As Variant)

End Sub

Notice that the event contains two parameters: Pointer and Value.
Pointer is the index of the pointer that changed and value is the new
value of the selected pointer. You can use these parameters in your event
procedure to help you process the event. For example, you can use the
Value parameter to scale a data point named data by the new value of the
pointer as soon as it changes:

Private Sub CWKnobl_PointerValueChanged (ByVal_
Pointer As Long, Value As Variant)
'data is a global variable.
data = data * Value
End Sub

@ Note You can use the underscore line-continuation character to span a single statement
over several lines of code, which is especially useful for displaying long strings in your
code. The underscore line-continuation is used throughout this manual to indicate that a
line of code continues; however, you can remove the continuation character when you
include a complete statement on a single line.
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Alternatively, you can generate an event procedure in the code editor.
Figure 2-5 shows how to create the event procedure for the KeyPress
event on a CWKnob control named CWKnobl1. Select the control from the
left list and then the event you want to define from the right list of the code

editor.
A Project] - Form1 [Code] [ _ (O] <]
ICW'I{nuM j PointerYalueChanged j

GotFocus -
HoeyDiorwn
b
End Sub Weylp
LostFocus
Private Jub CWEnobl PointerValuedWouseDown
'data iz a glohal variskhle. |[MouzeMove

Private Sub CWEnobl KeyFress (Feyl

| R |

data = data * Value rITDEJnS‘tEU':II h J
ointervalueChange
End Sub FointervalueCommitted
ReadyStateChange I 5
== alidate hd
=4 | =/

Figure 2-5. Selecting Events in the Code Editor

@ Tip Use the code editor to generate any event procedure for any control on the form
without switching back and forth to the form window.

How Do | Benefit from Using ActiveX Controls?

Custom ActiveX controls address your specific industry needs. For
example, ComponentWorks provides measurement and automation tools
to help you develop custom measurement and automation applications in
the environment that you choose. Furthermore, ActiveX controls are tools
for developing event-driven applications, they are easy to configure and
use, and they can help you create your own reusable software components.

¢ Work in any ActiveX control container. ActiveX controls enable
you to implement component-based software in any ActiveX control
container. Many integrated development environments are ActiveX
control containers because they support the standard interfaces needed
to communicate with ActiveX controls. Microsoft Visual Basic, Visual
C++, Excel, Word, Internet Explorer, and Borland Delphi users can
take advantage of ActiveX controls in their development environment
or Microsoft Office tool.

ActiveX control containers offer standard tools to help you develop
basic interfaces and programs, but you often need custom tools to
create your applications. Custom ActiveX controls provide specific
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functionality that is not available through native controls in your
development environment, and they enable you to get the exact
functionality you need without leaving your development
environment. Furthermore, custom ActiveX controls are widely
distributed across the Internet, so you can find a custom control for
almost anything you can imagine.

Develop event-driven programs. ActiveX controls are tools for
developing event-driven programs, rather than loop-driven programs.
In event-driven programming, the program runs continuously waiting
for events to occur. When an event occurs, the program responds to
it and then waits for the next event to occur. Event-driven
programming saves processor time, requires less code, and enables
you to add new controls with new functionality without rewriting any
loop-driven code.

Easily configure and use ActiveX controls. ActiveX controls deliver
an easy-to-use property page interface for configuring controls during
design time; a simplified API for accessing properties, methods, and
events programmatically; and 32-bit performance. Furthermore,
ActiveX controls communicate with the container, so you can take
advantage of your development environment’s features, such as the
Visual Basic Object Browser and code completion.

Create your own software components. ActiveX controls are easy to
develop in Microsoft Visual Basic. You can combine many different
ActiveX controls on one form to create a single component that
contains the exact functionality that you need. You then can use your
custom component as a reusable software component in other
programs or in HTML files to add interactive functionality to a

Web page. Web browsers with ActiveX support, including Internet
Explorer 3.0 or later and Netscape with the ActiveX plug-in, can view
the embedded control.
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Getting Started
with ComponentWorks
in Visual Basic
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In this chapter, you will practice using ComponentWorks in Visual Basic.
At the end of this tutorial, you will have learned to design a graphical user
interface; acquire, visualize, and analyze data; and distribute your
completed program.

Tip Refer to the Microsoft Visual Basic documentation if you need more information
about programming in Visual Basic after completing this tutorial. If you are an advanced
Visual Basic programmer and need more information about developing programs with
ComponentWorks, refer to the ComponentWorks online reference (Start»Programs»
National Instruments»Measurement Studio»Online Help»ComponentWorks
Reference for Visual Basic).

You need the following tools to complete this tutorial:

e Microsoft Visual Basic. Although this example uses Visual Basic 6
terminology, you can implement the example in Visual Basic 4 or later.

* National Instruments ComponentWorks. If you have not purchased a
licensed version of ComponentWorks, visit the National Instruments
ComponentWorks Web site at www.ni.com/cworks and follow the
links to download ComponentWorks evaluation software.

e National Instruments DAQ hardware and NI-DAQ 6.5 or later. Or you
can experiment with the Serial, GPIB, or VISA controls if you have
serial, GPIB, or VXI instruments or controllers.

Creating a ComponentWorks Project Template

Goal Create a project template to hold all of the components needed to develop similar
programs. Templates provide a way for you to reuse components and code. For example,
if you develop a lot of acquisition programs, you might have a template named Acquisition
that includes the ComponentWorks DAQ and User Interface controls and perhaps even a
standard interface that simulates your acquisition process. If you develop a lot of
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automation projects, you might have a template named Automation that contains the
ComponentWorks User Interface, Automation Symbols, and PID components and a
standard user interface that simulates the process on your production floor.

For this tutorial, you’ll create a standard ComponentWorks template
(CWProject) that contains the ComponentWorks User Interface, DAQ, and
Analysis controls. You can use the template over and over as you develop

similar programs.

1. Launch Visual Basic.

Open a new Standard EXE project.

2
3. Right click on the Visual Basic Toolbox and select Components.
4

Select National Instruments CW Analysis, National Instruments
CW DAQ, and National Instruments CW UL

@ Note If you don’t see the controls you want to load, press the Browse button and select
the following ActiveX control files from your Windows System folder: cwanalysis.ocx,
cwdaq.ocx, and cwui . ocx. Depending on the ComponentWorks package you own, you
might have the following ComponentWorks controls to include in this or other project
templates:

3D Graph Control

Instrument Controls (GPIB and Serial)

VISA Control

IVI DMM Control
IVI Scope Control
IVITools Control
DataSocket Control
IMAQ Vision
Automation Symbols

Autotuning PID

Getting Started with ComponentWorks 3-2

cw3dgrph.ocx
cwinstr.ocx
cwvisa.ocx
CWIviDmm.ocx
CWIviScope.ocx
CWIviTools.ocx
cwds.ocx
cwimag.ocx
cwas.ocx

cwpid.ocx
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5. Click OK. Visual Basic loads the ComponentWorks controls into the
Toolbox, as shown in Figure 3-1.
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Figure 3-1. Loading the ComponentWorks Controls into the Toolbox

6. Save the form and project in the Visual Basic \Template\Projects
directory as CWForm and CWProject.

@ Tip Only projects found in the \Template\Projects directory appear in the New
Project dialog box. You can change the path for your template directory in the Visual Basic
options (Tools»Options» Environment).

7. Close the project.
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Visualizing Data on a User Interface

Goal Create a user interface to get and display data. The interface is very simple,
consisting of a graph and Get Data button, as shown in Figure 3-2. When the program is
complete, you’ll be able to press the Get Data button and display an array of random
numbers on the graph.

Figure 3-2. Creating a Simple User Interface

1. Open a new Visual Basic project with the CWProject template from
the New Project dialog. Notice that you have a new project with the
ComponentWorks controls already loaded. Refer to Creating a
ComponentWorks Project Template for information about creating
the CWProject template.

2. Place a ComponentWorks Graph (CWGraph) control on the form.
o A form is the window or area on the screen on which you place
controls and indicators to create the user interface for your program.
Select the CWGraph icon from the Visual Basic Toolbox, and use your
mouse to click and drag on the form where you want the graph to
appear.

@ Tip If you have trouble finding a control in the Toolbox, hold your mouse over each
control icon to see the tooltips.
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3. Select the graph, and look at the most important environment property
in the Visual Basic Properties window—the control name. Name is the
most important environment property because it’s the name you’ll use
to programmatically access and control the graph. Visual Basic named
the CWGraph control CWGraphl.

4. Double click on the CommandButton control icon in the Toolbox to
place a pushbutton control on the form. Notice that Visual Basic places
the control in the middle of the form.

r

L)

Tip You can place controls on the form two ways. Either double click on a control in the
Toolbox or select it and click and drag on the form to place the object. If you double click
on the control in the Toolbox, Visual Basic places the control in the middle of the form.
Use your mouse to move and resize the control.

5. Click and drag on the button to move it below the graph.

The CommandButton control is a native Visual Basic control. One of
the benefits of developing programs with ActiveX controls is that you
can use the control that provides the exact functionality your program
requires, whether it is a native Visual Basic control or a custom
ActiveX control like the ComponentWorks Graph.

Because the CommandButton is a native Visual Basic control, it has
only one set of properties (environment properties), so you will use
only the Visual Basic Properties window to set properties for this
control. Notice that Visual Basic named this control Command1,
which is not very descriptive. Change the name to cmdGetData.

L)

Tip Quite a few naming conventions for variables and constants exist, but the most
common one is the Hungarian notation. With this notation, each variable and constant
name is proceeded by three to four letters that reflect the data type. For instance, zxt
proceeds a name for a TextBox, cmd refers to a CommandButton, and bl represents a
Label. You can find many more of these prefixes in Visual Basic guides.

6. Change the Caption property to Get Data. To edit a property,
highlight the property value on the right side of the property window
and type in the new value.

With the user interface completed, you can write code to generate data and
display it on the graph. There’s only one event—pressing the Get Data
button. When you press the button, an array of random numbers is
generated and plotted on the graph.
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7. Double click on the Get Data command button. The code editor opens

with the event procedure skeleton, as follows:

Private Sub cmdGetData_Click ()

End Sub

The first line indicates that you are writing a procedure to be called
every time the user clicks on the cmdGetData object (the Get Data
button).

8. The following procedure declares two variables: data is the array of
generated Y values to be plotted on the graph, and 1 is the loop counter.
Each time the loop runs, a Y value is created with the Visual Basic Rnd
method and added to the data array. The loop iterates 50 times to
create an array of 50 Y values, and then the procedure plots the data.
Insert the bolded code in the event procedure:

Private Sub cmdGetData_Click ()
Dim data (0 to 49) As Double, i
For i = 0 To 49
data(i) = Rnd * 10
Next i
CWGraphl.PlotY data
End Sub
@ Tip Take advantage of code completion in Visual Basic 5 and later. After you enter the

name of a control and a period, the code editor prompts you with a list of available
properties and methods.

9.

Getting Started with ComponentWorks

10.

Test the program. Press the Start button in the Visual Basic toolbar to
start the program, and then press the Get Data button. The graph plots
all 50 points of data and stops, waiting for the next event to occur. You
can press the Get Data button again, and another 50 points are plotted
on the graph.

Press the End button in the Visual Basic toolbar to stop the program
and return to design mode.
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Analyzing Data

Goal Find and display the mean value of the data you are generating. Figure 3-3 shows
the new interface, which uses the ComponentWorks Statistics (CW Stat) control to find the
mean and a Visual Basic Label control to display the value.

Figure 3-3. Analyzing Data

A 1. Place a Visual Basic Label on the form to display the mean value.

Change the control name to IbIMeanValue and the border style to
Fixed Single. Also, delete the default caption text so that the indicator
will be empty, rather than displaying Labell, when the program first
runs. Use an additional Visual Basic Label to identify the indicator as
the mean.

Tﬂ 2. Place a CWStat control on the form and use its Mean method to find
A and display the mean value. Notice that Visual Basic names this
control CWStatl.

@ Note To access the functionality of any ActiveX control, whether graphical or
non-graphical, you have to place the control on the form. If the control does not have a
graphical interface, it does not appear on the user interface during runtime. For example,
you have to place the CWStat control on the form to access its functionality, but it does not
appear on the user interface during runtime.
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Add the bolded code to the existing event procedure to find the mean
value in data (the array of generated data) and display it as the caption
in the IbIMeanValue indicator:

Private Sub cmdGetData_Click ()

Dim data(0 to 49) As Double, i

For i = 0 To 49

data(i) = Rnd * 10

Next i

CWGraphl.PlotY data

lblMeanValue.Caption = CWStatl.Mean (data)
End Sub

Run the program and press the Get Data button to display the mean
value. Press Get Data again, and notice that the mean value changes
because a new set of random data was generated. Stop the program
when you finish testing.

Interacting with the Data

Goal Interact with the data from the user interface. For this example, scale the data by the
value that appears on a knob, as shown in Figure 3-4.

Getting Started with ComponentWorks

Scale Factor 10—
50 B

Figure 3-4. Interacting with Data
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1. Place a ComponentWorks Knob (CWKnob) control on the form as
wh shown in Figure 3-4. Notice that Visual Basic names the control

CWKnobl. Right click on the knob and select Properties to modify
its custom properties. On the Numeric page, change Minimum and
Maximum to 10 and 100, so that you can scale the data by 10 to 100.
Make the knob caption display Scale Factor. Click OK.

2.  Modify the bolded line of code as follows to scale the data according
to the value of the knob on the user interface:

Private Sub cmdGetData_Click ()

Dim data(0 to 49) As Double, 1

For 1 = 0 To 49

data(i) = Rnd * CWKnobl.Pointers(1l) .Value

Next i

CWGraphl.PlotY data

1blMeanValue.Caption = CWStatl.Mean (data)
End Sub

3. Runthe program and press Get Data. Notice that the data looks similar
because the data is scaled by 10, as it was before. Turn the knob to 50
and press Get Data again. Notice that the mean value increases and the
graph has autoscaled to accommodate larger values. Stop the program
when you finish testing.

Acquiring Analog Data

5

Goal Acquire live data from a DAQ device. You already know how to visualize, analyze,
and interact with data, and now you can use the ComponentWorks Analog Input (CWAI)
control to add analog input functionality.

Note You need a National Instruments DAQ board installed and configured to run this
example. Alternatively, if you have a serial, GPIB, or VXI instrument or controller, you can
use an Instrument control rather than the CWAI control. Load the Instrument and VISA
controls to the Visual Basic Toolbox and use the correct commands to read from the
instrument if you use them.

Al 1. Place a CWAI control on the form. Notice that Visual Basic named
it it CWAIL. After placing the control on the form, use the

ComponentWorks custom property pages to interactively select
your device and acquisition settings.

Tip Right click on any ComponentWorks control and select Properties to set custom
properties for that control.
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2. Select your data acquisition device from the drop-down list.

Click the New button to create a new CWAIChannel object.

A CWAIChannel object holds the configuration for the channel or set
of channels that you want to read. You can add more CWAIChannel
configurations with the New button or delete existing configurations
with the Del button.

4. Type 1 or the channel you want to read in Channels. Figure 3-5 shows
how your Channels property page might look.

Property Pages E

Channels | Buffer | Clocks | Conditions | About |

Device 2 [PCI-MIO-T1BE-1) |2: PCI-MI0-TEE j

- EET
- Upper limit; Default Channels: |1
- Lowyer limit: Dvefault ez (i m
i~ Input mode: Default
- Coupling: Default Lowwer fimit: IDEF‘?'L’lIt ]'
Input mode: I Drefault hd |
Caupling: | Diefault - |

ﬂewl Qellgdill‘rlll

ak. I Canicel | Apply | Help |

Figure 3-5. Configuring Analog Input Channels

@ Tip If you configure named channels with National Instruments Measurement &
Automation Explorer, you can use named channels rather than channel numbers.

5. On the Buffer page, change the Number of scans to acquire to 50 so
that only 50 points of data are acquired.

6. Click OK to apply the settings and close the property pages.

Consider how this program will work with its new interface and analog
input feature. You will press Get Data and then wait for the data to appear
on the graph and the mean to be displayed in the indicator. You then might
change the scale factor with the knob and press Get Data again. Now
consider what you need to do programmatically to make it work.

First, the board needs to be configured with the settings from the CWAI
property pages and then it needs to acquire 50 data points. When all

50 points have been acquired, the CWAI control will generate the
AcquiredData event, indicating that the data has been acquired and is
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ready for some sort of processing. For this example, you can use the
AcquiredData event to scale and plot all 50 data points and then calculate
the mean. Therefore, you need to modify the existing event procedure for
the Get Data button and create a new event procedure to handle the data
after it is acquired.

7.

Modify the event procedure for the Get Data button as follows,
making sure to delete existing lines of code that do not appear below:

Private Sub cmdGetData_Click ()
'Configure the device with settings from the
'CWAI property pages.
CWAIl.Configure
'Start the acquisition.
CWAIl.start
End Sub

Double click on the CWAI control to create the AcquiredData event
procedure skeleton and then add the bolded code to the procedure:

Private Sub CWAI1l_AcquiredData (ScaledData _
As Variant, BinaryCodes As Variant)
Dim i
'Scale each point with the value from the knob.
For i = 0 To 49
ScaledData (i) = ScaledData (i) *_
CWKnobl .Pointers (1) .Value
Next
'Plot the scaled data.
CWGraphl.PlotY ScaledData
'Find and display the mean.
lblMeanValue.Caption = CWStatl.Mean (ScaledData)
End Sub

@ Note Notice that the Variant ScaledData holds all acquired data. The CWAI control
passes this array to the event procedure so that the data can be processed.

9.

© National Instruments Corporation

Run the program. Press Get Data, and watch the graph plot all

50 points of data and stop, waiting for the next event to occur. Change
the scale factor to see how the graph and mean change. Press Get Data
again, and watch another 50 points get plotted on the graph. Stop the
program when you finish testing.
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Continuously Acquiring and Charting Data

Goal Acquire and chart a continuous stream of data from your analog input device.

1. Use the Conditions property page for the CWAI control to set the stop
condition to Continuous. A stop condition specifies when the DAQ
device should stop acquiring data after the acquisition is started. The
Continuous option keeps the acquisition running until a user stops the
program.

2. Modify the graph plot method to display the data on a strip chart:
Private Sub CWAI1l_AcquiredData (ScaledData _

As Variant, BinaryCodes As Variant)
Dim i
'Scale each point with the value from the knob.
For i = 0 To 49
ScaledData (i) = ScaledData (i) *_
CWKnobl.Pointers (1l) .Value

Next
'Chart the scaled data.
CWGraphl.ChartY ScaledData
'Find and display the mean.
1blMeanValue.Caption = CWStatl.Mean (ScaledData)

End Sub

@ Note PlotY and ChartY are the two most common methods for passing data to a graph.

Use plotY when you have a finite number of points and you don’t need to see data that
was visualized before the current data set. Use ChartY to continuously display data, as on
a strip chart, and set the ChartLength property to keep a record of historical data.

Getting Started with ComponentWorks

Test the program. Run the program and press the Get Data button.
Figure 3-6 shows the program during runtime. Notice that data is
continuously acquired and displayed on the graph like a strip chart. Try
changing the scale factor, and notice how the graph and mean respond
to scaling. Stop the program when you finish testing.
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Figure 3-6. Continuously Acquiring and Charting Data

4. Save the project and form as Acquire Data.

Error Handling

Goal

Include error handling in your program so that it can continue running if an error

occurs. If you don’t include error handling, the ComponentWorks controls generate
exceptions when errors occur, forcing you to terminate your program. Use the Visual Basic
On Error statement or the I/O control return values and error events to handle errors so

that your program can continue to run.

Visual Basic On Error Statement

Use the On Error statement to handle errors, as in the following examples.
Refer to the Visual Basic documentation for more information about the on

Error statement.

* On Error Resume Next enables the program to continue running at
the next line. To handle an error in this mode, check and process the
information in the Err object in your code, as in the following

example:

Private Sub Acquire_Click()

On Error Resume Next

'Configure.
CWAIl.Configure

© National Instruments Corporation
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'Display error message if one occurs

'during Configure.

If Err.Number <> 0 Then MsgBox "Configure: "
+ CStr (Err.Number)

'Start the acquisition.

CWAIl.Start

'Display error message if one occurs

'during Start.

If Err.Number <> 0 Then MsgBox "Start: "_
+ CStr (Err.Number)

End Sub

* On Error GoTo enables the program to continue running at the
specified location in the procedure. In the following example, the same
error handler is called if an error occurs with either Configure or
Start:

Private Sub Acquire_Click ()
On Error GoTo ErrorHandler
CWAIl.Configure
CWAIl.Start
Exit Sub
'Display error message if one occurs
'during Configure or Start.

ErrorHandler:
MsgBox "DAQ Error: " + CStr (Err.Number)
Resume Next
End Sub
@ Tip Use the ComponentWorks DAQTools (CWDAQTools) control and the

GetErrorText method to convert an error code into descriptive error information.

The following example saves the return code in the DAQError variable and, if the value
indicates a warning or event, uses the GetErrorText method to retrieve textual
information about it:

'Get return code.
DAQError = CWAIl.Start
If DAQError <> 0 Then
'Display message box with error information.
MsgBox CWDAQToolsl.GetErrorText (DAQError)
End If
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Return Values

The ComponentWorks I/O controls (DAQ, Instrument, VISA, IVI, and
IMAQ) can return error codes rather than generating exceptions, which
force you to enter debug mode or terminate the program. Error codes are
generated by hardware controls if an error occurs during specific contexts
of an operation.

If you set the ExceptionOnError property to false, the I/O control
methods do not generate exceptions but return a status code that indicates
whether the operation completed successfully. If the return value is
something other than zero, a warning or error occurred. Positive return
values indicate that a problem occurred in the operation, but that the
program can continue running. Negative return values indicate that a
critical problem has occurred in the operation and that all other functions
or methods depending on the failed operation also will fail.

To retrieve the return code from a method call, assign the value of the
function or method to a long integer variable and check the value of the
variable after calling the function or method. For example, the following
code checks the return value of the start method on a CWAI control:

'Get the return value for the Start method.

lerr = CWAIl.Start

'Display an error message if one occurred.

If lerr <> 0 Then MsgBox "Error at DAQ Start: "
+ CStr(lerr)

If you want to check the return value in several different event procedures,
write one error handler for your program rather than duplicating it for every
call to a function or method. Remember that you can use the
ComponentWorks DAQTools (CWDAQTools) control and the
GetErrorText method to convert an error code into descriptive error
information. For example, the following code creates a LogError
subroutine to use with the start method and later functions or methods:

Private Sub LogError (code As Long)
'Display error if one occurs.
If code <> 0 Then

MsgBox "DAQ Error: " + _
CWDAQToolsl.GetErrorText (code)
End If
End Sub
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Call LogError before every function or method call, as in the following
line of code:

LogError CWAIl.Start

The return value is passed to LogError and processed.

Error and Warning Events

The DAQ controls include their own error and warning events (DAQError
and DAQWarning), and the Instrument, VISA, IVI, and IMAQ controls
include an error event. Using warning and error events, you can develop
event procedures for error checking asynchronous operations, such as
continuous analog input or asynchronous instrument control.

By default, only asynchronous operations call error and warning events.
If you are working with the ComponentWorks DAQ controls, you can use
the ErrorEventMask property to force other operations or contexts to
generate error and warning events. Refer to the online reference for
information about the ErrorEventMask property.

Testing and Debugging

Test and debug your program as needed. Visual Basic provides many debugging
tools. If you experience some unexpected behavior in your program, use these tools to
locate and correct the problem. Refer to your Visual Basic documentation for more
information about debugging techniques.

Printing Variables during Program Execution

One of the most common debugging methods is to print out or display
important variables throughout program execution. You can monitor
critical values and determine when your program varies from the expected
progress. Some programming environments have dedicated debugging
windows that are used to display such information without disturbing the
rest of the user interface. You can use the Debug.Print command in
Visual Basic to print information directly to the debug window. For
example, the following code displays the first channel or channels that you
are reading:

Debug.Print CWAIl.Channels.Item(l).ChannelString
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Monitoring Variables during Program Execution

Use a watch window to display the value of a variable during program
execution. You can use it to edit the value of a variable while the program
is paused. In some cases, you can display expressions, which are values
calculated dynamically from one or more program variables.

Examining and Debugging during Program Execution

The Immediate window opens during runtime in break mode, which means
that you can examine and debug your program while it is running. For
example, you can type or paste a line of code and press <Enter> to run it.
Or you can copy and paste code from the Immediate window into the code
editor.

@ Note Visual Basic does not save the content of the Immediate window. Copy any code
from the Immediate window that you want to save.

Executing the Program One Line at a Time

Use single stepping to execute a program one line at a time to check
variables and the output from your program as it runs. Single stepping is
commonly used after a breakpoint to slowly step though a questionable
section of code.

If you use step into, the program executes any code available for
subroutines or function calls and steps through the code one line at a time.
Use this mode if you want to check the code for each function called. The
step over mode assumes that you do not want to go into the code for
functions being called and runs them as one step.

In some cases, you might want to test a limited number of iterations of a

loop but then run the rest of the iterations without stopping. For this type of
debugging, several environments include the step to cursor or run to cursor
options. Under this option, you can place your cursor at a specific point in
the code, such as the first line after a loop and run the program to that point.

Stopping Program Execution at Breakpoints

Most development environments include breakpoint options so you can
suspend program execution at a specific point in your code. Breakpoints are
placed on a specific line of executable code in the program to pause
program execution.

© National Instruments Corporation 3-17 Getting Started with ComponentWorks



Chapter 3

Getting Started with ComponentWorks in Visual Basic

Stopping at a breakpoint confirms that your program ran to the line of code
containing the breakpoint. If you are unsure whether a specific section of
code executes, place a breakpoint in the procedure to find out. Once you
have stopped at a specific section of your code, you can use other tools,
such as a watch window or debug window, to analyze or even edit variables.

In some environments, breakpoints might also include conditions so
program execution halts if certain conditions are met. These conditions
usually check program variables for specific values. Once you have
completed the work at the breakpoint, you can continue running

your program, either in the normal run mode or in some type of
single-step mode.

Preparing Your Program for Distribution

Add finishing touches to the analog input program to prepare it for distribution.
This section explains some Visual Basic features that you can use to further customize your
programs. Refer to your Visual Basic documentation for more information about
customizing your programs in Visual Basic.

Positioning the Form on the Screen

@

You can use the Form Layout window to position the program form
exactly where you want it to appear when your customer runs it. Select
View»Form Layout Window and drag-and-drop the form anywhere on
the Form Layout window screen.

Tip Right click in the Form Layout window and select resolution guides to help you
precisely position the form or select a predefined startup position, such as the center of the

Customizing the Title Bar

You can set environment properties in the Visual Basic Properties window
to further customize the form and its title bar. For example, change the
Caption property to Acquire Data to customize the title bar text. You can
specify the icon that the program displays in the title bar or Windows Start
menu with the Icon property. You might use your company’s icon or create
a new icon for your custom program.
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Making an Executable

Now that you have a program to distribute to customers, Visual Basic
makes it easy to create an executable version ( . exe) so that your customers
don’t have to run the Visual Basic project. Anyone running Windows
2000/NT/9x can run Visual Basic executables. For this example, select
FilexMake Acquire Data.exe and complete the dialogs. To run the
executable, double click the icon for the executable file.

Building a Distributable Package

To install a program using ComponentWorks controls on another
computer, you must install the necessary control files and supporting
libraries. You can create an automatic installer to install your program and
all the files needed to run that program or you can manually install the
program and program files.

Whichever installation method you choose, you must install all necessary
OCX files to enable your program to create the controls on a different
computer, and you must register all OCXs with the operating system. You
also need to install driver software and corresponding hardware if your
program performs any I/O operations requiring separate driver software,
such as data acquisition or GPIB. Remember to configure the software
drivers.

@ Note You can redistribute the OCX files and related DLLs on your CD.

The Microsoft Visual Studio Package & Deployment Wizard provides tools
to help you package all components you need to distribute and build an
installer. This wizard automatically includes all ActiveX controls (OCXs)
that you used, any system files required to run your program on another
computer, dependency files to identify the run-time files needed to run the
program on a different computer, and the Visual Basic run-time file needed
to run any Visual Basic executable on a Windows computer. The wizard
also lets you specify the default location of the installed files.

@ Note If you use the evaluation version of ComponentWorks to develop your program,
the distributable version of your program will also use the evaluation version of
ComponentWorks.
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Implementing a Full-Featured Application

You have created a simple, yet versatile program to acquire data from a
DAQ device and visualize that data on a graph. Try adding the following
features to this simple analog input example to create a more robust custom
application:

Getting Started with ComponentWorks

Additional interface controls to make the program more user friendly.
Did you notice that to stop the acquisition you had to stop the Visual
Basic program? Instead, you could place a Stop button on the user
interface so that your customers don’t have to quit the program every
time they want to stop the acquisition.

Data logging. Use Visual Basic to log data to a file as it is acquired, and
then continue using your own software to analyze the data and generate
reports. For example, you can import the data into Microsoft Excel or
National Instruments HiQ and analyze it there. Refer to the
ComponentWorks Analog Input—Acquiring and Logging Data in
Visual Basic application note at www.ni . com.

Internet connectivity with ComponentWorks DataSocket. Use the
ComponentWorks DataSocket ActiveX control to publish live data
over the Internet. Refer to the Building an Interactive Web Page with
DataSocket application note www.ni . com.

Multiple instrument control with DAQ, GPIB, Serial, VISA, or IVI.
Control different kinds of instruments using the same program
architecture. Refer to the Application Note library at www.ni . com for
technical papers and tutorials about instrument control.
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Technical Support Resources

This appendix describes the comprehensive resources available to you in
the Technical Support section of the National Instruments Web site and
provides technical support telephone numbers for you to use if you have
trouble connecting to our Web site or if you do not have internet access.

NI Web Support

To provide you with immediate answers and solutions 24 hours a day,
365 days a year, National Instruments maintains extensive online technical
support resources. They are available to you at no cost, are updated daily,
and can be found in the Technical Support section of our Web site at
www.ni.com/support

Online Problem-Solving and Diagnostic Resources

* KnowledgeBase—A searchable database containing thousands of
frequently asked questions (FAQs) and their corresponding answers or
solutions, including special sections devoted to our newest products.
The database is updated daily in response to new customer experiences
and feedback.

*  Troubleshooting Wizards—Step-by-step guides lead you through
common problems and answer questions about our entire product line.
Wizards include screen shots that illustrate the steps being described
and provide detailed information ranging from simple getting started
instructions to advanced topics.

e Product Manuals—A comprehensive, searchable library of the latest
editions of National Instruments hardware and software product
manuals.

* Hardware Reference Database—A searchable database containing
brief hardware descriptions, mechanical drawings, and helpful images
of jumper settings and connector pinouts.

¢ Application Notes—A library with more than 100 short papers
addressing specific topics such as creating and calling DLLs,
developing your own instrument driver software, and porting
applications between platforms and operating systems.
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Technical Support Resources

Software-Related Resources

e Instrument Driver Network—A library with hundreds of instrument
drivers for control of standalone instruments via GPIB, VXI, or serial
interfaces. You also can submit a request for a particular instrument
driver if it does not already appear in the library.

* Example Programs Database—A database with numerous,
non-shipping example programs for National Instruments
programming environments. You can use them to complement the
example programs that are already included with National Instruments
products.

e Software Library—A library with updates and patches to application
software, links to the latest versions of driver software for National
Instruments hardware products, and utility routines.

Worldwide Support

National Instruments has offices located around the globe. Many branch
offices maintain a Web site to provide information on local services. You
can access these Web sites from www.ni.com/worldwide

If you have trouble connecting to our Web site, please contact your local
National Instruments office or the source from which you purchased your
National Instruments product(s) to obtain support.

For telephone support in the United States, dial 512 795 8248. For
telephone support outside the United States, contact your local branch
office:

Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20,
Brazil 011 284 5011, Canada (Calgary) 403 274 9391,

Canada (Ontario) 905 785 0085, Canada (Québec) 514 694 8521,

China 0755 3904939, Denmark 45 76 26 00, Finland 09 725 725 11,
France 01 48 14 24 24, Germany 089 741 31 30, Greece 30 1 42 96 427,
Hong Kong 2645 3186, India 91805275406, Israel 03 6120092,

Italy 02 413091, Japan 03 5472 2970, Korea 02 596 7456,

Mexico (D.F.) 5 280 7625, Mexico (Monterrey) 8 357 7695,

Netherlands 0348 433466, Norway 32 27 73 00, Poland 48 22 528 94 06,
Portugal 351 1 726 9011, Singapore 2265886, Spain 91 640 0085,
Sweden 08 587 895 00, Switzerland 056 200 51 51,

Taiwan 02 2377 1200, United Kingdom 01635 523545
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A

ActiveX

ActiveX control

ActiveX control
container

analog I/O

API

array

asynchronous

breakpoint

© National Instruments Corporation G-1

Set of Microsoft technologies for reusable software components. Formerly
called OLE.

Reusable software component that adds functionality to any ActiveX
control container through exposed properties, methods, and events. The
ComponentWorks Data Acquisition, User Interface, and Analysis controls
are examples of ActiveX controls.

Development environment that fully supports ActiveX controls and
integrates them into its own environment using COM. An ActiveX control
container enables you to specify how ActiveX controls interact with the
environment through environment properties. Visual Basic is an example of
an ActiveX control container. See also environment property.

Reading or writing data in continuously variable physical quantities, such
as voltage or current.

Application Programming Interface. A specification of software functions
and their input and return parameters.

Ordered, indexed set of data elements.

Function that begins an operation and returns control to the program prior
to the completion or termination of the operation.

Testing and debugging tool that allows you to select a program line at which
execution will automatically stop.
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channel

code completion

code editor

collection

COM

control

control property

counter/timer I/0

Pin or wire lead to which you apply or from which you read the analog or
digital signal.

Code writing feature that prompts you with next element in the line of code.
In Visual Basic 5.0 and later, when you enter the name of a control, the code
editor prompts you with the names of all available properties and methods.

Window where you write code. In Visual Basic, the code editor provides
several features to make writing code easier: automatic code completion,
automatic quick info, and bookmarks. The automatic quick info feature
displays the syntax for statements and functions as you enter them in the
code editor. Bookmarks mark lines of code in the code editor so that you
can find and return to them later.

Object that contains a number of objects of the same type, such as pointers,
axes, and plots. In ComponentWorks, the name of the collection is the
plural of the name of the objects in the collection. For example, a collection
of CWAXxis objects is called CWAxes. To reference an object in the
collection, you must specify the object as part of the collection, usually by
index. For example, CWGraph.Axes.Item(2) is the second axis in the
CWAxes collection of a graph.

Component Object Model. Microsoft specification for architecting and
developing reusable software components.

1. ActiveX control. See ActiveX control.

2. Object for entering or manipulating data on a user interface. Compare to
indicator.

Property that defines the way an ActiveX control looks and behaves. You
can set control properties programmatically or with custom property pages.

Reading or writing data based on high-precision timing through a counter
or timer. By combining a counter with a highly accurate clock, you can
create a wide variety of timing and counting applications, such as
monitoring and analyzing digital waveforms and generating complex
square waves.
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DAQ

DataSocket

debug

device

device number

digital I/O

DLL

DMM

dot notation

driver

Glossary

Data acquisition. Process of acquiring data, typically from A/D or digital
input plug-in boards.

Technology that simplifies live data exchange between applications and
HTTP, FTP, OPC, and file servers over the Internet. It provides one
common API to a number of different communication protocols.

Find and correct errors in a program.

Plug-in data acquisition board that performs analog input and output,
digital input and output, and counter/timer operations.

Slot number or board ID number assigned to the board when it is
configured.

Reading or writing digital representations of data in discrete units (the
binary digits 1 and 0). Digital information is either on or off.

Dynamic Link Library. A library of functions that link to a program and
load at runtime rather than being compiled into the program. Loading
libraries only when they are needed saves memory in software applications.

Digital Multimeter. A common measurement instrument that measures
resistance, current, and voltage in a wide variety of applications.

Programming syntax that allows you to access attributes and methods or
functions on an object. For example, object .attribute = value allows
you to set attribute on object to a new value.

Software that controls a specific hardware device, such as a data acquisition
board or GPIB interface board.
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E

environment property

€rror

error event

error handler

event

event-driven

event procedure

exception

executable
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Property that defines how an ActiveX control interacts with the
development environment and the rest of the user interface that you are
developing. The development environment provides default values for
environment properties, but you can modify the default values to better
integrate the ActiveX control in your program.

Critical problem in a software application that causes the operation or
program to fail.

Object-generated response to an error. The ComponentWorks DAQ, GPIB,
Serial, VISA, IVI, and IMAQ I/O controls generate error events for which
you can define event procedures. See also warning event.

Function, subroutine, or section of code that processes errors if one should
occur during program execution. Refer to the Visual Basic documentation
for information about the On Error statement. See also error event and
warning event.

Object-generated response to some action or change in state, such as a
mouse click or a completed acquisition. The event calls an event procedure
that processes the event. Events are defined as part of an ActiveX control
object.

Describes a program that runs continuously, waiting for an event to occur.
When an event occurs, the program calls the appropriate event procedure.
Compare to loop-driven, where a program continuously polls to find out if
anything has changed.

User-defined function called in response to an event from an object. See
event.

Error message generated by a control and sent directly to the application or
programming environment containing the control.

Program file with a . exe extension that you can run independently of the
development environment in which it was created.
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form

FTP

FTP Server

GPIB

GUI

HTML

HTTP

HTTP Server

Hungarian notation
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Window or area on the screen on which you place controls and indicators
to create the user interface for your program.

File Transfer Protocol. Protocol based on TCP/IP to exchange files between
computers.

Application running on a computer that enables the storing and retrieving
of files by different clients via FTP. Most FTP servers allow anonymous
connections so that any networked user can exchange files.

General Purpose Interface Bus. The standard bus used for controlling
electronic instruments with a computer. Also called IEEE 488 bus because
it is defined by ANSI/IEEE Standards 488-1978, 488.1-1987, and
488.2-1987.

Graphical User Interface. A user interface that has graphics, controls,
indicators, and/or menus.

HyperText Markup Language. Syntax used to build Web pages. HTML
files are downloaded from an HTTP server and viewed in a Web browser,
such as Internet Explorer.

HyperText Transfer Protocol. Protocol based on TCP/IP, which is used to
download Web pages from an HTTP server to a Web browser.

Application running on a computer that serves Web pages and other
information to client computers using HTTP. Clients display Web pages in
Web browsers but can retrieve information using other tools, like a
DataSocket client.

Object-naming notation where each variable and constant name is
proceeded by three to four letters that reflect the data type. For example,
intValue is a variable of type integer.
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I/0

IEEE 488

IMAQ Vision

Immediate window

indicator

installer

instrument driver

IVI

Input/Output. The transfer of data to or from a computer system involving
communication channels, operator interface devices, and/or data
acquisition and control interfaces.

Shortened notation for ANSI/IEEE Standards 488-1978, 488.1-1987, and
488.2-1987. See also GPIB.

National Instruments image acquisition and analysis software that you can
use to acquire images from National Instruments image acquisition
(IMAQ) boards, display them in your program, perform interactive viewer
operations, and analyze the images to extract information.

Visual Basic debugging tool. The Immediate window opens during runtime
in break mode, which means that you can examine and debug your program
while it is running. For example, you can type or paste a line of code and
press ENTER to run it. Or you can copy and paste code from the Immediate
window into the code editor.

Object for displaying data on a user interface. Compare to control.

Software program that copies program, system, and other necessary files to
computers. You can use tools such as the Microsoft Visual Studio Package
& Deployment Wizard to create installers for programs you want to
distribute to others.

Library of functions to control and use one specific physical instrument.
Also a set of functions that adds specific functionality to an application.

Interchangeable Virtual Instruments. A technology involving standard
programming interfaces for classes of instruments, such as oscilloscopes,
DMMs, and function generators, that results in hardware-independent
instrument drivers. The IVI standard programming interfaces have been
defined by the IVI Foundation, an industry consortium. See
www.ivifoundation.org.
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LED

loop-driven

MB

Measurement &
Automation Explorer

method

named channel

NI-DAQ

Glossary

Light-Emitting Diode. An indicator that emits a light when current passes
through it. For example, an LED shows if your computer or printer is
turned on.

Describes a program that uses a main loop to keep polling the program for
changes. Compare to event-driven.

Megabytes of memory.

National Instruments tool for configuring your National Instruments
hardware and driver software; executing system diagnostics; adding new
devices, interfaces, and virtual channels; and viewing devices and
instruments connected to your system.

Function that performs a specific action on or with an object. The operation
of the method often depends on the values of the object properties.

Channel configuration that specifies a DAQ device; a hardware-specific
channel string; channel attributes such as input limits, input mode, and
actuator type; and a scaling formula for making a measurement or
generating a signal in terms of your actual physical quantity. You can create
named channels for National Instruments devices in Measurement &
Automation Explorer.

Driver-level software to control and communicate with DAQ hardware.
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0

object Reusable, self-contained programming structure that encapsulates data and
functionality. An object has exposed properties, methods, and events so that
you can programmatically control how the object looks and behaves. Also
known as a software object. See property, method, and event.

Object Browser Visual Basic tool that displays the available properties, methods, and events
for the controls that are currently loaded in the development environment.
The Object Browser shows the hierarchy within a group of objects. Press
<F2> in Visual Basic to open the Object Browser.

OCX OLE Control eXtension. Another name for ActiveX controls, reflected by
the . ocx file extension of ActiveX control files.

OLE Object Linking and Embedding. See ActiveX.
OLE control See ActiveX control.
OPC OLE for Process Control. An industry standard based on ActiveX and

COM technologies that enables you to create a single client application that
can communicate with disparate devices. See www.opcfoundation.org.

OPC Server OLE for Process Control Server. A COM-based standard defined by the
OPC Foundation that specifies how to interact with device servers.

oscilloscope Measurement instrument widely used in high-speed testing applications,
such as telecommunication physical layer testing, video testing, and
high-speed digital design verification.

P

parameter Value passed to a method or function.

PID Proportional-Integral-Derivative. A three-term control mechanism
combining proportional, integral, and derivative control. You might use a
PID algorithm to control processes such as heating and cooling systems,
fluid level monitoring, flow control, and pressure control.

plot 1. Trace (data line) on a graph representing the data in one row or column
of an array.

2. To display a new set of data while deleting any previous data on the
graph. Use one of the P1ot methods on the CWGraph control to plot data.
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pointer

property

property pages

R

return value

S

scope

serial

software object

synchronous

syntax

Glossary

Indicator on a CWSlide or CWKnob object. You can use a collection of
pointers to display different values on the same object. In the collection,
each pointer is referenced by an index in the collection and each individual
pointer has its own properties such as color, style, mode, and so on.

Attribute that defines the appearance or state of an object. The property can
be a specific value or another object with its own properties and methods.
For example, a value property is the color (property) of a plot (object),
while an object property is a specific Y axis (property) on a graph (object).
The Y axis itself is another object with properties, such as minimum and
maximum values.

Window or dialog box that displays current configuration information and
allows users to modify the configuration. Also called property sheets.

Status code that indicates whether an operation completed successfully.
If the return value is something other than zero, a warning or error
occurred. Positive return values indicate a warning, a problem that occurred
in the operation but that will not stop the program from running. Negative
return values indicate an error, a critical problem that occurred in the
operation and that will stop all other functions or methods that depend on
the failed operation from completing successfully.

See oscilloscope.

Standard serial bus on a computer used to communicate with instruments.
Also known as RS-232.

See object.

Property or operation that begins and returns control to the program only
when the operation is complete.

Set of rules to which statements must conform in a particular programming
language.
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Ul

v

value pairs

Variant

VISA

VXI

W

warning

warning event

watch window

User Interface. See GUI.

Paired name and value that you can use for custom ticks, labels, and grid
lines on the axis of a knob, slide, or graph.

Data type that can hold any defined type of data. Visual Basic converts all
data as needed to save it in a variable of type Variant.

Driver-software architecture developed by National Instruments to unify
instrumentation software for serial, GPIB, and VXI instruments or
controllers. It has been accepted as a standard for VXI by the
VXlplug&play Systems Alliance.

VME eXtension for Instrumentation. Instrumentation architecture and bus
based on the VME standard. Used in high-end test applications.

Non-critical problem in a software application.

Object-generated response to a warning. The ComponentWorks DAQ and
IMAQ I/0O controls generate warning events for which you can define event
procedures. See also error event.

Visual Basic debugging tool that displays the value of variables during
program execution.
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Index

Symbols

_ (line continuation character), 2-11

A

acquiring analog data, 3-9 to 3-13
ActiveX control containers, 2-12
ActiveX controls, 2-1 to 2-13
benefits of using, 2-12 to 2-13
custom controls, 2-12, 3-3, 3-5
events, 2-10 to 2-12
loading in Visual Basic, 3-2 to 3-3
methods, 2-8 to 2-10
naming, 3-5
native (Visual Basic) controls, 3-3, 3-5
overview, 2-1 to 2-3
placing on a form, 3-4, 3-5
properties, 2-4 to 2-8
Analog Input (CWAI) control, 3-9 to 3-13
Analysis controls, 1-2, 3-7 to 3-8
analyzing data, 3-7 to 3-8
application notes, viii
Automation Symbols controls, 1-3

breakpoints, 3-17 to 3-18
building a distributable package, 3-19

C

calling methods, 2-8 to 2-9, 3-7

code completion, 3-6

code examples
AcquiredData event, 3-11, 3-12
adding an object to a collection, 2-9
calling Analysis functions, 3-8
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calling methods, 2-8, 2-9
charting data, 3-12
Click event, 3-6, 3-8, 3-9, 3-11, 3-13, 3-14
configuring devices, 3-11, 3-13, 3-14
Debug.Print, 3-16
displaying error information, 3-14
displaying messages, 3-13, 3-14
displaying values on the user

interface, 2-8, 3-8
Err object, 3-13, 3-14
using event parameters in procedures, 2-11
For loop, 3-6, 3-11
generating event procedure skeletons, 2-11
generating random data, 3-6
GetErrorText method, 3-14
getting a property, 2-7
If-Then statements, 3-13, 3-14
Item method, 2-10
On Error statement, 3-13, 3-14
plotting data, 3-6
printing values, 2-8, 3-16
removing objects from a collection, 2-9
using return values, 3-15
saving a value from a method call, 2-8
scaling data with user interface controls, 3-9
setting a property, 2-7
setting properties on collection items, 2-10
starting acquisitions, 3-11, 3-13, 3-14

collections, 2-3, 2-9 to 2-10
ComponentWorks

application notes, viii
controls, 1-2 to 1-3

error handling, 3-13 to 3-16
examples, viii, ix
installation, 1-4 to 1-5
overview, 1-1to 1-3
packages, 1-1
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property pages, 2-5
reference, ix
samples, viii, ix
system requirements, 1-3
template for Visual Basic, 3-1 to 3-3
tutorial, 3-1 to 3-20
control properties, 2-4
customizing a program title bar, 3-18

D

Data Acquisition controls, 1-2, 3-9 to 3-13
data logging, 3-20
DataSocket control, 1-2, 3-20
debugging, 3-16 to 3-18
breakpoints, 3-17 to 3-18
Immediate window, 3-17
Print function, 3-16
stepping through code, 3-17
watch window, 3-17
distributing programs, 3-19
DMM control, 1-2
documentation
conventions, x
getting started with, vii to ix
related documentation, vii to ix

E

environment properties, 2-4
error events, 3-16
error handling, 3-13 to 3-16
events, 3-16
GetErrorText method, 3-14, 3-15
On Error statement, 3-13 to 3-14
return values, 3-15
ErrorEventMask property, 3-16
event procedures, 2-10, 2-11
event-driven programming, 2-11
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events, 2-10 to 2-12
developing event procedures, 2-11,
3-6, 3-11
error, 3-16
warning, 3-16
examples, viii, ix
using ComponentWorks in Visual Basic
(tutorial), 3-1 to 3-20
See also code examples.
ExceptionOnError property, 3-15
exceptions, 3-13
executable, 3-19

F

Form Layout window, 3-18
forms, 3-4, 3-18

G

GetErrorText method, 3-15
getting started, vii to ix

GPIB control, 1-2, 3-9

Graph (CWGraph), 1-2, 3-4 to 3-6
graphing data, 3-4 to 3-6

H

Hungarian notation, 3-5

IMAQ Vision controls, 1-3

Immediate window, 3-17

installers, 3-19

installing ComponentWorks, 1-4 to 1-5
Instrument controls, 1-2, 3-9
interacting with data, 3-8 to 3-9
Internet connectivity, 1-2, 3-20

Item method, 2-9 to 2-10

IVI controls, 1-2
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K

Knob (CWKnob), 3-8 to 3-9

L

line continuation, 2-11
loading controls, 3-2 to 3-3
loop-driven program, 2-11

making an executable, 3-19
manipulating data, 3-8 to 3-9
manual. See documentation.
Measurement Studio, 1-1
methods, 2-8 to 2-10
calling, 2-8 to 2-9, 3-7
default method, 2-10
GetErrorText, 3-15
passing parameters, 2-8 to 2-9

naming conventions, 3-5
National Instruments Web support, A-1

0

objects, 2-1 to 2-3
online problem-solving and diagnostic
resources, A-1

P

Package & Deployment Wizard, 3-19
parameters, 2-8 to 2-9

PID control, 1-3

placing controls, 3-4, 3-5

Print function, 3-16
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Index

program distribution, 3-18 to 3-19
building a distributable package, 3-19
making an executable, 3-19

programming
event-driven, 2-11
loop-driven, 2-11

project template, 3-1 to 3-3

properties, 2-4 to 2-8
control, 2-4, 3-9
default property, 2-7
environment, 2-4, 3-5, 3-7
ErrorEventMask, 3-16
ExceptionOnError, 3-15
property pages, 2-5 to 2-6
setting programmatically, 2-6 to 2-8

Properties window, 2-6, 3-5

property pages, 2-5 to 2-6

R

redistributable files, 3-19
requirements (system), 1-3
return values, 3-15

run to cursor, 3-17

S

scaling data with user interface controls, 3-11
Scope control, 1-2

Serial control, 1-2, 3-9

single stepping, 3-17

software objects, 2-1 to 2-3

software-related resources, A-2

Statistics (CWStat), 3-7 to 3-8

stepping (through code), 3-17

system requirements, 1-3
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T

technical support resources, A-1
telephone support, A-2
template (Visual Basic project), 3-1 to 3-3
testing, 3-16 to 3-18
Three-Dimensional Graph control, 1-2
title bar, 3-18
tutorial, 3-1 to 3-20
acquiring analog data, 3-9 to 3-13
analyzing data, 3-7 to 3-8
charting data, 3-12 to 3-13
distributing programs, 3-18 to 3-19
error handling, 3-13 to 3-16
expanding your program, 3-20
interacting with data, 3-8 to 3-9
testing and debugging, 3-16 to 3-18
visualizing data, 3-4 to 3-6

u

User Interface controls, 1-2, 3-4 to 3-6,
3-8 to 3-9

v

VISA control, 1-2, 3-9

Visual Basic, 3-1 to 3-20
breakpoints, 3-17 to 3-18
code completion, 3-6
code editor, 2-12
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debugging, 3-16 to 3-18
error handling, 3-13 to 3-16
forms, 3-4, 3-18
Immediate window, 3-17
line continuation, 2-11
loading controls, 3-2 to 3-3
On Error statement, 3-13 to 3-14
Package & Deployment Wizard, 3-19
Print function, 3-16
Properties window, 2-6, 3-5
stepping through code, 3-17
template, 3-1 to 3-3
Toolbox, 3-3
tutorial, 3-1 to 3-20
watch window, 3-17
visualizing data, 3-4 to 3-6, 3-12 to 3-13

W

warning events, 3-16
watch window, 3-17
Web support from National Instruments
online problem-solving and diagnostic
resources, A-1
software-related resources, A-2
worldwide technical support, A-2
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